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Support de stockage grande capacité
● Vous pouvez utiliser le disque dur intégré pour stocker toute votre discothèque.

Vous pouvez également l'utiliser comme disque dur externe pour votre PC et y
stocker d'autres fichiers de données.

Lecture de fichiers MP3, WMA, audio ASF et Ogg
● Votre lecteur peut lire les fichiers MP3, WMA, ASF Audio et Ogg.

Port d’accueil USB
● Vous pouvez librement transférer des données, comme de la musique ou des

images sans utiliser de PC, en raccordant directement des périphériques
numériques, comme un appareil photo numérique, un lecteur MP3, etc. au lecteur.

Fonction lecteur vidéo
● Vous pouvez visionner des fichiers vidéo après le téléchargement par le studio multimédia.

Fonction visionneuse de fichiers images et textes
● Vous pouvez visualiser les fichiers JPEG et TXT.

Enregistrement MP3 direct 
● Vous pouvez transformer de la musique d’un CD, une cassette ou la radio en

fichiers MP3.
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Transfert de données haut débit USB 2.0

SON SRS WOW Surround 
(Son ambiophonique SRS WOW)
● La fonction Surround 3D (SRS) ajoute de l'espace au son.

Écran ACL TFT 18 pouces couleur
● Vous obtenez ainsi des images et des vidéos de haute qualité.

Support de jeux divers
● Vous pouvez profiter de jeux comme Te tris, Omok et Othello.

Batterie rechargeable Li-Ion incorporée
● La batterie rechargeable au lithium intégrée permet d’écouter jusqu’à 25 heures

de musique et de visionner jusqu’à 5 heures 30 minutes de vidéo.

Fonction contrôle de la vitesse de lecture
● Vous pouvez régler la vitesse de lecture des fichiers musicaux ou vocaux.

Possibilité de mise à jour
● Vous pouvez mettre à jour les programmes intégrés le cas échéant.

Veuillez vérifier la présence de mises à jour sur la page d'accueil du site
http://www.samsung.com.



Contenu

4

I Chapitre 1 Préparation
Caractéristiques .......................................2
Avertissements de sécurité......................6
Consignes de sécurité relatives au
chargeur de batterie.................................8
Précautions à prendre lors du chargement .9
Accessoires............................................10
Emplacement des commandes .............11
Affichage ................................................12

I Chapitre 2 Connexion à l’ordinateur
Connexion à l'ordinateur ...........................13

● Installation du logiciel ............................13
● Connexion du lecteur à un PC au moyen 

d'un câble USB ....................................15
Utilisation de Windows Media Player 10...16

● Téléchargement de fichiers musicaux.......16
Utilisation du lecteur comme 
périphérique de stockage. ........................18
Transférer des fichiers enregistrés............19
Installation de Multimedia Studio..............20

● Installing Multimedia Studio Software.......20
Utilisation de Multimedia Studio ...............22

● Modification d'images ............................22
● Envoi des images .................................23
● Envoyer des vidéos...............................25
● Capture vidéo ......................................27
● Affichage de l'Aide de Multimedia Studio ..30

I Chapitre 3 Utiliser le Lecteur
Écouter de la musique..............................31

● Lecture de musique ..............................31
● Pause de la musique.............................31
● Réglage du volume...............................31

Fonction Verrou ........................................32
Répétition en boucle .................................32

● Point de départ.....................................32
● Point d’arrivée ......................................32

Recherche de fichiers musicaux/vocaux ..33
● Recherche d’une section particulière 

durant la lecture.........................................33
● Recherche d’un fichier spécifique 

durant la lecture.........................................33
● Changement de piste lorsque 

le lecteur est arrêté ....................................33
Fonctions principales en mode musical....34

● Add to Favorites (Ajouter aux favoris).......34
● EQ (Égalisateur)...................................34
● DNSe (Digital Natural Sound Engine) 

(Sonorité naturelle numérique)................35
● Play Mode (Mode lecture) ......................35
● Play Speed (Vitesse de lecture) ..............36
● File Info. (Inf. du fichier)........................36

Options du MENU.....................................37
Dictaphone................................................38
Enregistrer des fichiers MP3 ....................39
Réglage des principales fonctions du 
mode Navigation .......................................40

● Go to Top (Aller en haut)........................41
● Scroll Type (Type de defilement)..............41
● Add to Favorites (Ajouter aux favoris).......42
● Delete File (Supprimer dossier)...............42



5

Contenu

F
R

A

I Chapitre 3 Utiliser le Lecteur
Visualiser un texte ....................................43
Réglage des principales fonctions du 
mode Texte................................................44

● Bookmark (Signet) ................................44
● Go to Page (Aller à la page) ...................45
● Page Scroll Type (Défilement d’une page).46
● Auto Scroll (Défilement automatique) .......46

Affichage des fichiers image.....................47
Visionnage de fichiers vidéo.....................48
Utiliser le port USB ...................................49

● Connexion d’un appareil externe .............49
● Transférer des fichiers d’un appareil 

externe au lecteur.................................50
● Hôtes compatibles avec le YH-J70J.........52

Jeux ..........................................................53
● Clear Screen .......................................53
● Press [START] to start game. .................54
● Tetris ..................................................56
● Chips..................................................57

Fonctions avancées ..................................58
Réglage de l’affichage ..............................59

● Scroll Speed (Vitesse de défilement) .......59
● Backlight (Rétroéclairage) ......................59

Durée avant extinction de l’écran ACL .....60
● LCD Off Time (Temps de fermeture écran ACL) .60
● Text Set (Réglage du texte) ....................60
● Graphic EQ (Graphique égalisateur) ........60

Réglage des effets sonores ......................61
● 3d User Set (Réglage option 3D) ............61
● Street Mode (Mode rue).........................61
● Fade In (Fondu)....................................61
● Auto EQ (Égalisateur automatique)..........62
● User EQ Set (Réglage option égalisateur) 62

Réglage de l’heure/du calendrier..............63
● Memo (Mémo) .....................................63
● Calendar (Calendrier)............................64
● Sleep (Sommeil)...................................65
● Date/Time (Date/Heure).........................65

Paramètres d’enregistrement....................66
● Bit Rate (Débit binaire) ..........................66
● Auto Sync (Sync. Automatique)...............66
● Languages (Langues) ...........................67
● File Language (Dossier langue) ..............67

Paramètres Système ................................68
● Resume (Résumé)................................68
● PC Connect Mode (Mode connexion au PC) ....68
● Auto Off Time (Temps de fermeture automatique) .69
● Sort (Classement).................................69
● Default Set (Réglage par default) ............69
● About (A propos de)..............................69

I Chapitre 4  Annexes
MENU Table ..............................................70

I Chapitre 5 Support Clientèle
Dépannage ...............................................71
Spécifications............................................72



Avertissements de sécurité

6

Merci de lire attentivement toutes les instructions afin d’éviter toute blessure ou dommage à l’appareil.

✽ Veuillez noter que nous déclinons toute responsabilité pour les dommages liés à la perte de données enregistrées
ou sauvegardées suite à une panne, une réparation ou à toute autre cause.

Ne laissez aucun corps
étranger pénétrer 
à l’intérieur de l’appareil.

N’exposez pas l’appareil
à des produits chimiques
tels que du benzène ou
des diluants.

N’appliquez pas de pression
excessive sur l’appareil.

Ne placez pas d’objets
lourds sur le dessus de
l’appareil.

Ne touchez jamais le
chargeur si vous avez les
mains mouillées.

N’exposez pas l’appareil
à la lumière directe du
soleil ou à des sources
de chaleur.

Ne placez pas l’appareil
dans un endroit comportant
beaucoup de poussière ou
de suie.

N'utilisez pas le lecteur près
d'un autre appareil susceptible
de générer un champ
magnétique important.

Ne tentez pas de
démonter ou de réparer
vous-même l’appareil.

N’exposez pas l’appareil à
des températures extrêmes
(supérieures à 35°C ou
inférieures à -5°C). Ne
placez pas l’appareil dans
un endroit humide.
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Suivez les consignes de sécurité relatives à la circulation
● N’utilisez pas les écouteurs en conduisant une voiture ou en circulant à vélo.

Cela est non seulement dangereux mais également interdit par la loi.
● Vous risquez d’avoir un accident si le volume des écouteurs est trop élevé lorsque vous marchez

dans la rue.

Protégez vos oreilles
● Ne montez pas le volume trop haut.

Les médecins émettent des mises en garde contre l’exposition prolongée à des volumes excessifs.
● Cessez d’utiliser l’appareil ou baissez le volume si vous ressentez des bourdonnements d’oreilles.

● L’utilisateur doit veiller à ce que le câble des écouteurs ne se coince pas dans son bras ou dans tout autre
objet pendant qu’il marche ou qu’il fait du sport.

● Conformez-vous aux directives locales concernant l’élimination des déchets lorsque vous vous
débarrassez d’emballages, de piles et d’appareils électroniques usagés.

● L’emballage de votre lecteur est constitué de carton, de polyéthylène, etc., et ne comporte aucun
matériau inutile.

● Température ambiante: 5°C ~ 35°C (41°F ~ 95°F) 
● Humidité : 10% ~ 75%

I Écouteurs

I Conditions ambiantes d’utilisation 

I Informations relatives à l’environnement
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!

!ATTENTION
RISQUE DE CHOC ÉLECTRIQUE. NE PAS OUVRIR

Les pièces non isolées contenues dans le
chargeur peuvent provoquer un choc électrique.
Pour votre sécurité, n'ouvrez pas le boîtier du
chargeur.

Lisez ce Manuel de l'utilisateur afin de prévenir
tout problème pouvant survenir lors de l'utilisation
de ce chargeur.

AAAAvvvveeeerrrr tttt iiii sssssssseeeemmmmeeeennnntttt
- N'utilisez pas le chargeur à proximité d'une source d'eau afin d'éviter tout risque d'incendie

ou de choc électrique.

AAAAtttt tttteeeennnntttt iiiioooonnnn
- Afin d’éviter tout risque de choc électrique, n’utilisez le chargeur que sur une prise de courant qui

correspond à la forme de la prise du transformateur.
- Assurez-vous que la fiche du chargeur est complètement insérée dans la prise murale.

✍

✍



9

Précautions à prendre lors du chargement

F
R

A

Un chargeur est fourni avec votre
lecteur.
Branchez le chargeur dans une prise
murale.
✻ Lorsque le chargement est terminé,

“Charge Completed” s'affiche sur l’écran.
✻ Pour recharger l’appareil via la connexion par

câble USB, sélectionnez [Settings] → [System]
→ [PC Connect Mode] → [Charge] dans le menu.
Pour procéder au rechargement via le câble USB,
le PC doit être sous tension. Si le PC passe en mode économie d’énergie, la batterie ne sera pas
rechargée.

✻ Le temps de charge via le câble USB est d’environ 6 heures, tandis que le temps de charge via le
chargeur n’est que d’environ 4 heures.

AAAAtttt tttteeeennnntttt iiiioooonnnn
- Afin d'éviter tout risque d'incendie, ne laissez pas la batterie se recharger plus de 12 heures.
- Ne branchez pas plusieurs appareils sur la même prise murale.
- N'utilisez pas un chargeur défectueux.
- Lorsque vous utilisez une batterie rechargeable pour la première fois ou lorsque celle-ci 

n'a pas servi pendant plusieurs mois, commencez par la recharger complètement.
- Une surcharge risque de réduire la durée de vie de votre batterie.
- La batterie rechargeable est un consommable et sa capacité va diminuer progressivement.
- Afin de prolonger la durée de vie de votre batterie, utilisez la batterie entièrement rechargée

jusqu'à ce qu'elle soit entièrement déchargée puis rechargez-la de nouveau complètement
avant de la réutiliser.

- Veuillez noter que nous déclinons toute responsabilité pour les dommages liés à la perte de
données enregistrées ou sauvegardées suite à une panne, une réparation ou à toute autre cause.
Cela risquerait de provoquer un incendie ou un choc électrique.

- Ne touchez jamais le chargeur si vous avez les mains mouillées.

✍



Accessoires

10

● La capacité de la mémoire utile incorporée est inférieure à ce qui est spécifié puisque le
micrologiciel interne utilise également une partie de la mémoire.

● Les caractéristiques des accessoires sont susceptibles d'être modifiées sans préavis à des
fins d'amélioration.

Lecteur Écouteurs Câble d'entrée
audio

Chargeur Câble USBadaptateur USB CD d’installation

Modèle

Mémoire intégrée

YH-J70J LB/LW

30 Go
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Touche
Répétition en
boucle/Enregis-
trement

Interrupteur
Hold (Verrou)

Touche MENU

Affichage

Prise écouteurs

Touche TOOL
(OUTILS)

[Arrière de
l’appareil]

TROU DE
RÉINITIALISATION

Touche d’alimentation
Touche lecture/pause

Touche Saut/Recherche

Touche
Sélection/Navigation/
Réglage du volume

Touche Saut/Recherche

Port de connexion par câble USB

Connecteur LINE IN
Microphone

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Réinitialisez le lecteur en enfonçant un objet pointu (un trombone, par exemple) dans le trou RESET.

✍
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Indicateur Lecture/Pause

Indicateur de volume

Indicateur Durée
de lecture

Indicateur de mode Lecture
Indicateur EQ/SRS

Indicateur de batterie restante

Affichage du numéro de
la chanson

Titre de la piste en
cours de lecture

Indicateur de progression

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Les illustrations ne sont reproduites qu’à titre d’exemple. L’écran réel peut être différent.

✍
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Installez Windows Media Player 10 avant de brancher
le lecteur au PC.

❑ Configuration système
nécessaire

Le PC doit avoir au minimum la
configuration suivante:
● Pentium 300 MHz ou plus
● Windows XP Service Pack 1 ou

supérieur.
● Windows Media Player 10.0 ou

supérieur
● Internet Explorer 6.0 ou supérieur
● 100 MB d'espace disque disponible 
● Lecteur CD-ROM 

(double vitesse au minimum)
● Prise en charge du port

USB (2.0)
● Version DirectX 9.0 ou

supérieure

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Connectez-vous à votre PC en tant

qu'administrateur (Utilisateur princi-
pal) et installez les logiciels fournis
(Media / Multimedia Studio) pour
Windows XP.
Vous pouvez modifier les informa-
tions du compte en sélectionnant
[Start] → [Control Panel] →
[User Account] à partir de la barre
des tâches de votre PC.

I Installation du logiciel

1 Insérez le CD d’installation dans le lecteur 

de CD-ROM.
L’image indiquée ci-dessous apparaît.
Sélectionnez [Install Windows Media Player 10].

✍
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2 Suivez les instructions à l’écran pour terminer l’installation.



15

Connexion à l'ordinateur

F
R

A

1 Connectez le câble USB au port USB de l’ordinateur.

2 Connectez l’autre extrémité du câble USB au port de connexion USB situé au bas
du lecteur.
● "Samsung YH-J70J" s’affiche dans la rubrique [Gestionnaire de périphériques] de votre ordi-

nateur.

I Connexion du lecteur à un PC au moyen d'un câble USB

PC

Câble USB

Lecteur
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- Vous pouvez télécharger des fichiers MP3 et WMA à l’aide de Windows Media Player 10.
- Les fichiers téléchargés depuis WMP10 vers le lecteur seront automatiquement sauvegardés

dans le dossier Music.

1 Connectez le lecteur à votre PC.

2 Lancez Windows Media Player10.
● Cliquez sur [Démarrer] → [Tous les programmes] → [Lecteur Windows Media] sur le

bureau.

3 Cliquez sur [Synchro] en haut de l’écran.

I Téléchargement de fichiers musicaux
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Utilisation de Windows Media Player 10

4 Quand la fenêtre [Synchro] s’affiche,
sélectionnez le fichier que vous
désirez transférer vers le lecteur et
faites-le glisser vers la fenêtre
[Liste à synchro] de gauche.

6 Vous pouvez examiner le fichier 
transféré dans la fenêtre de droite.

5 Vérifiez que les fichiers musicaux que vous
désirez télécharger sont cochés et appuyez
sur [Démarrer synchro] en haut de l'écran.
- Le message [Synchronized to Device] 

s’affiche dans la fenêtre de gauche.
Les fichiers téléchargés s'affichent dans la
fenêtre de droite dans le dossier Music.
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- Vous pouvez facilement transférer des fichiers de données vers le lecteur à l’aide de Windows
Explorer et l’utiliser comme périphérique de stockage pour stocker vos fichiers de données.

- Sélectionnez le mode de connexion au PC avant d’utiliser le périphérique de stockage.
Appuyez sur la touche MENU et sélectionnez [Settings] → [PC Connect Mode] → [MTP] dans le menu.

1 Connectez le lecteur au PC.

2 Faites un clic droit sur la touche Start, puis sélectionnez Explorer pour ouvrir
l’explorateur Windows.

● [Samsung YH-J70J] s’affiche dans l'explorateur Windows.

3 Sélectionnez le fichier de données à sauvegarder et faites-le glisser vers
[Samsung YH-J70J] → [Data].

AAAAtttt tttteeeennnntttt iiiioooonnnn
- La déconnexion du câble USB pendant l’affichage du message "Updating" (Mise à jour en cours)

peut endommager le lecteur.
- Vous ne pouvez pas envoyer un fichier supérieur à 400 MB depuis le lecteur vers le PC.

✍
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- Vous pouvez transférer des fichiers enregistrés sur le lecteur vers votre PC.

1 Connectez le lecteur au PC.

2 Faites un clic droit sur la touche Start, puis sélectionnez Explorer pour ouvrir l’explo-
rateur Windows.

3 Sélectionnez [Samsung YH-J70J] → [Data] → [RECORDED] depuis l’explorateur
Windows.
● Les fichiers enregistrés s’affichent.

4 Faites glisser les fichiers sélectionnés vers le dossier souhaité.
Le fichier sélectionné est transféré vers le dossier spécifié.



● Multimedia Studio est un programme qui prend en charge la modification d'images, la lecture
de séquences vidéo et la conversion de format, ainsi que la création d'albums multimédia.

I Installation du logiciel Multimedia Studio
1 Insérez le CD d’installation dans le lecteur de CD-ROM.

Sélectionnez [Install Multimedia Studio].

2 Sélectionnez la langue.

Installation de Multimedia Studio

20
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Installation de Multimedia Studio
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Suite...

3 Suivez les instructions à l’écran pour terminer l’installation.



● Lancez Multimedia Studio à partir du Bureau.

I Modification d'images
1 Sélectionnez le dossier contenant les images à 

partir de la fenêtre du répertoire située dans la 
section supérieure gauche de Multimedia Studio.
● Les fichiers enregistrés s'affichent dans la fenêtre

Liste de fichiers située à droite.

2 Sélectionnez l'image à modifier.
● L'image sélectionnée s'affiche dans la fenêtre

[Preview image].

3 Appuyez sur la touche [Edit Img].
● À partir de la fenêtre [Picture editor], vous pouvez accéder à des fonctions telles que

l'édition de papiers peints, l'édition de couches, l'insertion de clip-arts, la création de
cadres ainsi que d'autres fonctions d'édition.

NNNNooootttteeee
- Consultez la rubrique [Help] (Aide) de Multimedia Studio (page 30) pour plus d’informations.

✍

Utilisation de Multimedia Studio
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Utilisation de Multimedia Studio
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I Envoi des images
1 Connectez le lecteur à votre PC.

2 Sélectionnez les images à envoyer vers le lecteur.

3 Sélectionnez [File] → [Export images to device] en haut du menu Multimedia Studio.

4 Sélectionnez Samsung YH-J70J à partir de l'écran [Select device], puis appuyez 
sur la touche [OK].

5 Sélectionnez le dossier à enregistrer à partir de la fenêtre de sélection du dossier,
puis cliquez sur la touche [OK].

Sélectionnez le mode de connexion au PC avant de transférer des fichiers images ou
des fichiers vidéo au moyen de Multimedia Studio. Appuyez sur la touche MENU et
sélectionnez [Settings] → [PC Connect Mode] → [MTP] dans le menu.



6 Réglez la taille et déterminez le chemin de l'image dans la fenêtre
[Resize images], puis cliquez sur la touche [OK].
● L’image est envoyée vers le lecteur YH-J70J.

● L’image transférée peut être visionnée sur lecteur en sélectionnant 
[Photo/Video] → [Photo].

● La taille optimale pour afficher l'image sur l'appareil est 160 x 128.
Veuillez ajuster la taille de l'image si cette dernière ne s'affiche pas correctement sur le lecteur.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Le chemin fait référence à l'emplacement ou au dossier où les images converties sont

enregistrées sur votre PC.
- Les fichiers images enregistrés sur le lecteur peuvent être supprimés en sélectionnant

[File] → [Delete images from device].

- Consultez l'Aide pour plus d'informations.

✍

Utilisation de Multimedia Studio
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Utilisation de Multimedia Studio
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I Envoyer des vidéos

1 Connectez le lecteur à l’ordinateur.

2 Sélectionnez la(les) vidéo(s) à envoyer sur le lecteur.

3 Sélectionnez [File] → [Export videos to device] en haut de Mutlimedia Studio.

4 Sélectionnez Samsung YH-J70J à partir de l'écran [Select device], puis appuyez
sur la touche [OK].

Sélectionnez le mode de connexion au PC avant de transférer des fichiers images 
ou des fichiers vidéo au moyen de Multimedia Studio. Appuyez sur la touche MENU
et sélectionnez [Settings] → [PC Connect Mode] → [MTP] dans le menu.



5 Sélectionnez le dossier à sauvegarder dans l’écran de sélection et cliquez
ensuite sur [OK].

6 Cliquez sur la touche [Convert] lorsque l’écran de conversion apparaît.
● Le fichier converti est transmis en format .svi.
● Le fichier vidéo transféré peut être visionné sur le lecteur en sélectionnant Menu →

[Photo/Video] → [Video].

▲ Pour convertIr et transférer un fichier vidéo, il faut:
1. vérifier que Direct X 9.0 ou une version supérieure est installé sur votre ordinateur.
2. vérifier que Windows Media Player 9.0 ou une version supérieure est installé sur votre ordinateur.
3. Vérifiez que le Codec Pack a été installé dans le PC.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Les fichiers vidéo enregistrés sur le lecteur peuvent être supprimés en sélectionnant  [File] →

[Delete videos from device].
- Si vous disposez d’un fichier vidéo (Divx, Xvid, .avi, .mpg etc.) sur votre PC et que vous ne 

pouvez pas le visionner, il vous sera alors impossible de le convertir en format svi et de le lire sur
le YH-J70J. Il vous faudra tout d’abord trouver le bon codec sur Internet, puis l’installer sur votre
ordinateur. Une fois le codec installé, il vous sera possible de convertir le fichier en format .
svi à l’aide de Multimedia Studio et de le transférer vers votre lecteur.

- Reportez-vous à l’Aide de plus amples informations.

✍

Utilisation de Multimedia Studio
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Utilisation de Multimedia Studio
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I Capture vidéo

1 Appuyez sur la touche [Capture] située en
haut du menu de Multimedia Studio.
● L'écran Media Player s'affiche.

2 Cliquez sur [Menu] → [Open] sur votre PC et sélectionnez la vidéo que vous
souhaitez lire.
● La lecture de la vidéo sélectionnée commence.

Le logiciel Multimedia Studio vous permet de capturer une image fixe à partir d'un
fichier vidéo et de l’enregistrer en tant qu’image sur votre PC, puis de la transférer
vers le YH-J70J (voir page 23).



3 Appuyez sur la touche  [Capture] puis appuyez
sur la touche   [Capture] lorsque l'image que vous
souhaitez capturer apparaît.
● Les images sélectionnées sont capturées.

4 Appuyez sur la touche [Save].
● Enregistrer cette image capturée : permet d'enregistrer

l'image actuellement sélectionnée.
● Enregistrer toutes les images capturées : permet

d'enregistrer toutes les images capturées.

1

2

2

1

Utilisation de Multimedia Studio
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Utilisation de Multimedia Studio
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Suite...

5 Sélectionnez le dossier dans lequel les images doivent être enregistrées à l'aide
de la fenêtre [Save As], puis appuyez sur la touche [Save].
● L'image sélectionnée est enregistrée.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Les codecs de lecture vidéo et de conversion ne sont pas fournis. Nous vous recommandons

d'utiliser les toutes dernières versions des codecs.
- Consultez l'Aide pour de plus amples informations.

✍



I Affichage de l'Aide de Multimedia Studio
Lancez Multimedia Studio et appuyez sur la touche Aide située en haut de l’écran.

● L'Aide s’affiche.

Utilisation de Multimedia Studio

30



31
F

R
A

Écouter de la musique

I Lecture de musique

I Pause de la musique

● Mise sous tension : Maintenez la touche √» enfoncée pour mettre le lecteur sous tension.
● Mise hors tension : Maintenez la touche √» enfoncée pour mettre l'appareil hors tension.

Maintenez la touche √» enfoncée.
● La lecture commence automatiquement.

Appuyez sur la touche √» pour mettre la lecture sur
pause.
● En mode Pause, réappuyez brièvement sur la touche √»

pour reprendre la lecture.

Assurez-vous que le lecteur est entièrement chargé et que les écouteurs sont branchés.

Réglez le volume en déplaçant la touche SELECT vers le haut ou vers le bas.
● Le volume peut être réglé progressivement entre 00(MIN) et 60(MAX).

I Réglage du volume



I Point de départ
Pendant la lecture d’un fichier musical, appuyez sur 
la touche A↔B au début de la boucle que vous 
souhaitez définir.
● A↔ apparaît sur l'écran d'affichage.

Appuyez brièvement sur la touche A↔B à l’endroit où
vous souhaitez mettre fin à la répétition en boucle.
● A↔B apparaît sur l’écran d’affichage.
● La boucle est lue à plusieurs reprises.

Appuyez sur la touche A↔B brièvement pour annuler
la répétition en boucle.

I Point d’arrivée

Répétition en boucle

Utilisez la fonction Verrou (Hold) pour verrouiller toutes les touches et les rendre inactives.

Fonction Verrou (Hold) de l’appareil

Activez la touche de l’appareil.

❈ Toutes les touches de l’appareil sont rendues inactives.

❈ Lorsque vous activez le commutateur HOLD, un " " apparaît à l’écran.

Fonction Verrou 
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Recherche de fichiers musicaux/vocaux
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RRRReeeemmmmaaaarrrrqqqquuuueeee
- Fichier VBR (variable bit rate): un fichier qui change constamment de taux de compression

selon le type de son, par exemple leur ton, dans le fichier.
- Avec un fichier VBR, il peut être impossible d’atteindre et de lire la piste précédente même si la

touche est enfoncée dans les cinq secondes qui suivent le début de la lecture.
- Les fichiers téléchargés en MP2 ou MP1 dont l’extension a été changée en MP3 peuvent ne

pas être lus.

● Gardez la touche , enfoncée durant la lecture pour rechercher la section que vous
souhaitez écouter.

● Relâchez la touche pour reprendre la lecture normale.

I Recherche d’une section particulière durant la lecture.

● Pressez la touche brièvement durant la lecture pour avancer à la piste suivante.
● Pressez la touche brièvement dans les 5 secondes du démarrage de la lecture pour

reculer à la piste précédente. Pressez la touche brièvement après 5 secondes pour
redémarrer cette piste du début.

I Recherche d’un fichier spécifique durant la lecture.

● Pressez la touche , en mode arrêt/pause pour passer à la piste précédente/suivante.

I Changement de piste lorsque le lecteur est arrêté

✍



I EQ (Égalisateur)
- Vous pouvez régler le mode d’effet sonore comme vous le désirez

dans le menu EQ.

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le 
bas pour sélectionner [Add to Favorites], puis appuyez 
sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner la liste
que vous désirez sauvegarder vers [1-10], puis appuyez sur la touche SELECT.
● Le fichier sélectionné est transféré vers la liste. ● 10 listes de lecture peuvent être sélectionnées.
● Les fichiers ajoutés sont accessibles à partir du menu [Navigation] → [Playlist] → [Favorites].

1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas 
pour sélectionner [EQ], puis appuyez sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner le mode 
d’effet sonore désiré, puis appuyez sur la touche SELECT.
● Normal → Jazz → Classic → Pop → Rock → Bass Boost → Bass Cut → R&B → Club → Dance → House

→ High Boost → High Cut Loud → Ballad → Strings → Vintage → Vocal Boost → Bluesy → User EQ
● Lorsque vous utilisez le mode User EQ, l’effet sonore désiré peut être réglé à partir du

menu [Settings] → [Sound Effect] → [User EQ Set].

I Add to Favorites (Ajouter aux favoris)
- Vous pouvez facilement trouver et écouter vos morceaux de 

musique préférés en les ajoutant aux Favoris.

Add to Favorites
EQ
DNSe
Play Mode
Play Speed
File Info.

TOOL

TOOL

List 2

List 3

List 4

List 5

List 1

Fonctions principales en mode musical

34

Add to Favorites
EQ
DNSe
Play Mode
Play Speed
File Info.

Jazz

Classic

Pop

Rock

Normal
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Fonctions principales en mode musical
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1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour 
sélectionner [Play Mode], puis appuyez sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas 
pour sélectionner le mode Play désiré, puis appuyez sur la touche SELECT.
● Normal : Appuyez sur la touche SELECT après avoir placé le curseur sur [Normal].

- Folder : Permet de lire une fois le dossier en cours de lecture.
- All : Permet de lire une fois tous les fichiers dans l’ordre.

● Repeat: Appuyez sur la touche SELECT après avoir placé le curseur sur [Repeat].
- One : permet de répéter un fichier. - Folder : permet de répéter le dossier en cours de lecture.
- All : permet de répéter la lecture de tous les fichiers.

● Shuffle (Aléatoire) : appuyez sur la touche SELECT après avoir placé le curseur sur [Shuffle].
- Folder : permet de lire les fichiers du dossier dans un ordre aléatoire.
- All : permet de lire tous les fichiers dans un ordre aléatoire.

I Play Mode (Mode lecture)

1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool (Outil musical) apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour 
sélectionner [DNSe], puis appuyez sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le 
bas pour sélectionner le mode DNSe désiré, puis appuyez sur la touche SELECT.
● Normal → 3D-User → 3D-Studio → 3D-Stage → 3D-Club

Add to Favorites

TOOL

EQ

DNSe

Play Mode

File Info.

3D-User

3D-Studio

3D-Stage

3D-Club

Normal

I DNSe (Digital Natural Sound Engine) (Sonorité naturelle numérique)

RRRReeeemmmmaaaarrrrqqqquuuueeee
- DNSe est une fonction d’effets sonores pour lecteurs MP3 développée par Samsung, proposant les modes

3D, Bass Enhance (basse améliorée) et Street (rue). Le mode 3D ajoute un effet sonore en 3 dimensions à
la musique, le mode Bass Enhance renforce les basses et le mode Street propose une fonction de réglage
automatique du volume qui amplifie les sons faibles dans un environnement bruyant comme une rue.

✍

TOOL
Add to Favorites
EQ
DNSe
Play Mode
Play Speed
File Info.

Repeat

Shuffle

Normal
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1 Appuyez sur la touche TOOL en mode musique.
● L’écran Music Tool (Outil musical) apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le 
bas pour sélectionner [Play Speed], puis appuyez sur 
la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner la
vitesse de lecture désirée, puis appuyez sur la touche SELECT.
● 0.8x → 1x → 1.2x → 1.4x → 1.6x.
● Plus le chiffre est élevé, plus la vitesse de lecture est rapide et plus le chiffre est petit,

plus la vitesse de lecture est lente.

I Play Speed (Vitesse de lecture)

1 Appuyez sur la touche TOOL lorsque le
fichier musical est en cours de lecture
ou arrêté.
● L’écran Music Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut
ou vers le bas pour sélectionner [File Info],
puis appuyez sur la touche SELECT.
● Les informations sur le fichier en cours de lec-

ture/en pause s’affichent.

I File Info. (Inf. du fichier)

Blue Title

Artist

Album

Genres

File Size

Total Time

Sky

Best

Dance

7782656 bytes

00:03:25√

Fonctions principales en mode musical

TOOL
Add to Favorites
EQ
DNSe
Play Mode
Play Speed
File Info.

1x
1.2x
1.4x
1.6 x

0.8x
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Options du MENU

01 I Music 02 I Navigation 03 I Text

04 I Photo/Video 05 I USB Host 06 I Games 07 I Settings

● Music : Affiche la chanson en train d’être lue.
● FM Radio : Pour écouter la radio FM.
● Navigation : Permet d’accéder au mode Navigation et de parcourir les fichiers et les dossiers.
● Text  : Pour lire des fichiers texte.
● Photo/Video : Permet de visionner des fichiers image ou des vidéos.
● USB Host : Permet de transférer les fichiers enregistrés sur l’appareil vers des

périphériques externes ou de transférer des fichiers enregistrés sur des
périphériques externes vers le lecteur.

● Games : Permet de jouer.
● Settings : Permet de régler les fonctions.

Appuyez sur la touche MENU pour passer en mode MENU.
Utilisez la touche SELECT pour sélectionner l'élément du menu que vous désirez, puis 
appuyer brièvement sur la touche SELECT.

RRRReeeemmmmaaaarrrrqqqquuuueeee

- En mode Menu, appuyez sur la touche pour passer à l’écran précédent.

✍



Dictaphone

38

-REC:Start -TOOL:Exit

1 Maintenez la touche REC enfoncée.
● L’écran Recording apparaît.

2 Appuyez sur la touche REC pour commencer l'enregistrement vocal.

3 Appuyez à nouveau sur la touche REC.
● L’enregistrement s’arrête et le fichier est créé.
● Les fichiers sont enregistrés et renommés V001.mp3, V002.mp3, etc.
● Les fichiers MP3 ainsi créés sont enregistrés dans le dossier [Navigation] → [File Search]

→ [RECORDED] → [VOICE001]. Un dossier d’enregistrement peut contenir jusqu’à 999
fichiers.

● Appuyez sur la touche √» pour lire le fichier enregistré.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Même en augmentant le réglage du taux d’échantillonnage et du débit binaire, l’enregistrement

vocal sera par défaut à 44,1 kHz.

✍

V001.mp3
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Enregistrer des fichiers MP3
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1 Branchez le port Audio Out à la
source de son externe (ou le port de
Line Out) au port LINE IN sur le
lecteur avec le câble Line.
● Appuyez sur la touche de lecture de

l'appareil externe pour lire la musique
à enregistrer.

2 Maintenez la touche REC enfoncée.
● L’écran Recording apparaît.

3 Appuyez sur la touche REC.
● L’enregistrement commence.

4 Appuyez à nouveau sur la touche REC.
● L’enregistrement s’arrête et le fichier est créé.
● Les fichiers sont enregistrés et renommés L001.mp3, L002.mp3, etc.
● Les fichiers MP3 sont enregistrés dans le dossier [Navigation] → [File Search] →

[RECORDED] → [LINE001].
Un dossier d’enregistrement peut contenir jusqu’à 999 fichiers.

● Appuyez sur la touche √» pour lire le fichier enregistré.

AAAAtttt tttteeeennnntttt iiiioooonnnn
- Ne débranchez pas le câble de ligne pendant l'enregistrement.
- Si la batterie n’est pas suffisamment chargée, le fichier ne pourra pas être entièrement codé

par le lecteur.
- Ajuster le volume de la source de son externe à un niveau adéquat avant d'enregistrer.

Si le volume est trop élevé, la qualité sonore peut être mauvaise.

-REC:Start -TOOL:Exit L001.mp3

✍



File Search
Music Library
Playlist

Navigation

Sexy boms.mp3
blue.mp3
Ill be there for you.mp3
San eye.mp3
Only for you.mp3

Happy.mp3

MUSIC

1 Maintenez la touche SELECT enfoncée pour passer en mode Navigation ou appuyez sur
la touche MENU pour atteindre le Menu, puis sélectionnez Navigation.
● File Search: vous permet de rechercher un fichier dans les dossiers MUSIC, PHOTO, Pictures

TEXT ou VIDEO.
Les fichiers images transférés par le Multimedia Studio sont sauvegardés dans le dossier
Photo tandis que ceux transférés par WMP10 sont sauvegardés dans le dossier Images.

● Music Library : permet de rechercher un fichier musical par artiste, par album, par genre et par piste.
● Playlist: vous permet de rechercher un fichier donné enregistré comme Favoris sur le lecteur

ou sur une liste de lecture du PC transférée à l'aide de Windows Media Player 10.

2 Sélectionnez le fichier ou le dossier dont vous souhaitez commencer la lecture.
● : permet de revenir au dossier du niveau supérieur.
● : permet de revenir au dossier du niveau inférieur.
● ▲,▼ : permet de se déplacer vers un autre fichier ou dossier au sein d'un même répertoire.
● SELECT : permet de passer au dossier situé immédiatement en dessous.

3 Appuyez sur la touche SELECT.
● Le fichier sélectionné est lu.

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

Réglage des principales fonctions du mode Navigation

40

File Search
MUSIC
PHOTO
Pictures
RECORDED
TEXT
VIDEO
POP
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Réglage des principales fonctions du mode Navigation
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Go to Top
Scroll Type 
Add to Favorites

TOOL

1 Appuyez sur la touche TOOL en mode Navigation.
● L’écran Navigation Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner [Go to Top],
puis appuyez sur la touche SELECT.
● Entrez dans la fenêtre File Navigation.

1 Placer le curseur sur le fichier musical en mode Navigation, puis appuyez sur la
touche TOOL.
● L’écran Navigation Tool (Outil de navigation) apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner [Scroll Type],
puis appuyez sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner [Line
Up/Down] ou [Page Up/Down], puis appuyez sur la touche SELECT.
● Line Up/Down : Appuyez sur la touche SELECT vers le haut ou le bas, le texte défile ligne par

ligne à partir de l’écran de recherche de fichiers.
● Page Up/Down : Appuyez sur la touche SELECT vers le haut ou le bas, le texte défile page

par page à partir de l’écran de recherche de fichiers.

I Go to Top (Aller en haut)

I Scroll Type (Type de defilement)

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

File Search
Music Library
Playlist

Navigation



1 En mode Navigation, sélectionnez le fichier que vous 
désirez ajouter. Appuyez sur la touche TOOL pour afficher 
le menu TOOL.
● L’écran Navigation Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour 
sélectionner [Add to Favorites], puis appuyez sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner la liste
que vous désirez sauvegarder vers [1-10], puis appuyez sur la touche SELECT.
● Le fichier sélectionné est ajouté à la liste.
● 10 listes de lecture peuvent être sélectionnées.
● Les fichiers ajoutés sont accessibles à partir du menu [Navigation] → [Playlist] → [Favorites].

I Add to Favorites (Ajouter aux favoris)

● Les fichiers enregistrés peuvent être supprimés en
mode Navigation.

1 En mode Navigation, sélectionnez le fichier que vous
désirez effacer. Appuyez sur la touche TOOL pour
afficher le menu TOOL.
● L’écran Navigation Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas
pour sélectionner [Delete File], puis appuyez sur la touche
SELECT.
● Le fichier sélectionné est supprimé.

I Delete File (Supprimer dossier)
V001.MP3
V002.MP3
V003.MP3

VOICE001

Réglage des principales fonctions du mode Navigation
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Go to Top
Scroll Type 

Add to Favorites

TOOL

List 1
List 2
List 3
List 4
List 5

Go to Top
Scroll Type 

Delete File

TOOL
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Visualiser un texte
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RRRReeeemmmmaaaarrrrqqqquuuueeee
- Les fichiers texte d’une taille supérieure à 500 Ko ne peuvent être lus.

✍

You Can Be Happy
Identity.txt

TEXT You Can Be Happy 0011
/0102

I woke up this morning you
were the first thing on my
mind. I don't know where it
came from all I know is 
I need you in my life.You
make me feel like I can be 

1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Text.
● L’écran Navigation apparaît.

2 Déplacez le curseur sur le fichier texte que vous souhaitez lire, puis appuyez sur
la touche SELECT.
● Le texte sélectionné s'affiche.

- ▲,▼ : Permet de régler le volume.
- , : Permet d’atteindre la page précédente/suivante.
- Sélection du fichier texte : Appuyez sur SELECT et maintenez la touche pour naviguer

pendant que le fichier musical se lit. Placez le curseur sur le fichier texte désiré, puis
appuyez sur la touche SELECT.

04 I Text

● Le lecteur de texte vous permet de lire les fichiers texte créés sur votre ordinateur.
Les fichiers texte doivent être en extension .txt pour être lus sur le lecteur de texte.

● Vous pouvez sélectionner un fichier texte à visionner durant la lecture de musique.



Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Add
Move

● Vous pouvez effectuer une sélection à l’aide de la touche SELECT.
● Appuyez sur la touche pour passer à l’écran précédent.

1 Appuyez sur la touche TOOL pendant la lecture d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner [Bookmark],
puis appuyez sur la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner [Add] ou
[Move], puis appuyez sur la touche SELECT.
● Add : un signet est créé dans la page actuelle.
● Move : déplacer le marque-page dans le texte.

I Bookmark (Signet)

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Vous pouvez créer un signet dans un fichier ou 5 signets dans un répertoire.

✍

Réglage des principales fonctions du mode Texte

44



45

Réglage des principales fonctions du mode Texte
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You Can Be Happy 0011
/0102

I woke up this morning
you were the first thing on
my mind. I don't know
where it came from all I
know is I need you in my
life You make me feel like

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

0 0 1 1 /0102

Toutes les pages

1 Appuyez sur la touche TOOL pendant la lecture d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner 
[Go to Page], puis appuyez sur la touche SELECT.

3 Pour sélectionner la page désirée, appuyez sur les touches , afin de sélec-
tionner la boîte de saisie. Appuyez sur la touche NAVI vers le haut ou vers le bas
pour sélectionner un chiffre dans la boîte de saisie (cette opération définit le numéro
de la page). Appuyez sur SELECT et la page sera affichée.
Par exemple, afin d'afficher la page 47, sélectionnez 0047 dans les boîtes de saisie.

I Go to Page (Aller à la page)

▲ ▲ ▲ ▲

▲▲▲▲



1 Appuyez sur la touche TOOL pendant la lecture
d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas 
pour sélectionner [Page Scroll Type], puis appuyez sur 
la touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner les
paramètres de défilement désirés, puis appuyez sur la touche SELECT.
● Line Up/Down : en appuyant sur les touches et , le texte défile ligne par ligne.
● Page Up/Down : en appuyant sur les touches et , le texte défile page par page.

I Page Scroll Type (Défilement d’une page)

1 Appuyez sur la touche TOOL pendant la lecture
d’un fichier texte.
● L’écran Text Tool apparaît.

2 Appuyez sur la touche NAVI vers le haut ou vers le bas 
pour sélectionner [Auto Scroll], puis appuyez sur la 
touche SELECT.

3 Appuyez sur la touche NAVI vers le haut ou vers le bas pour sélectionner la
durée de défilement automatique désirée, puis appuyez sur la touche SELECT.
● Les options Off, 1, 3, 5 ou 10 secondes sont disponibles.
● La page défile automatiquement lorsque la durée indiquée est écoulée.

I Auto Scroll (Défilement automatique)

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Line Up/Down
Page Up/Down

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Off
1 sec
3 sec
5 sec
10 sec

Réglage des principales fonctions du mode Texte
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Affichage des fichiers image
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05 I Photo/Video
Photo
Video

Photo/Video
HOTELSEA.JPG
SKYSHOW.JPG
flowerpicture.jpg
manillasunset.jpg
sebusunrise.jpg

PHOTO

1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Photo/Video.
● L’écran Photo/Video apparaît.

2 Appuyez sur la touche SELECT après avoir sélectionné le dossier [Photo].

3 Déplacez le curseur sur l’image que vous souhaitez visionner, puis appuyez sur
la touche MENU.
● L'image sélectionnée s'affiche.
● ,▼ : permet de régler le volume.
● , : permet d’atteindre l’image précédente/suivante.
● MENU: permet d’ouvrir l’écran Menu.
● TOOL: permet d’afficher l’écran Tool (Outils). Sélectionnez [Slide Show] → [On] dans

l’écran Image Tool pour afficher les fichiers image enregistrés sous forme de diaporama.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- La taille optimale d’image pour ce lecteur est 160x128. Si la taille de l’image est trop grande,

utilisez Multimedia Studio pour régler la taille et renvoyez l’image sur le lecteur. (voir page 24).
- Les fichiers image d’une taille supérieure à 2 Mo ne peuvent être visionnés.

✍



05 I Photo/Video
Photo
Video

Photo/Video

Arthur.Svi
SDIARY.Svi
TOM.Svi

VIDEO

1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Photo/Video.
● L’écran Photo/Video apparaît.

2 Appuyez sur la touche SELECT après avoir sélectionné le dossier [Video].

3 Déplacez le curseur sur la vidéo que vous souhaitez visionner, puis appuyez sur
la touche MENU.
● Le fichier vidéo sélectionné est lu.
● ,▼ : permet de régler le volume.
● (Pression courte sur les touches) , : permet d’atteindre la vidéo précédente/suivante.
● (Pression longue sur les touches) , : recherche rapide
● MENU: permet d’ouvrir l’écran Menu.
● TOOL: permet d’afficher le titre de la vidéo, la durée écoulée et la durée totale.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Le lecteur ne prend en charge que les fichiers vidéo en extension .svi. Pour visionner des vidéos

en autre format, convertissez les fichiers en utilisant Multimedia Studio et ensuite transférez les fichiers
convertis au lecteur.
Pour transférer un fichier vidéo d'un format différent, consultez la rubrique “Envoyer des vidéos” dans
“Utilisation du Studio multimédia”. (voir page 25).

✍

Visionnage de fichiers vidéo
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Utiliser le port USB
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1 Connectez le lecteur à l’adaptateur USB.

2 Utilisez le câble USB de l’appareil externe pour connecter l’appareil externe à
l’adaptateur USB.

Lecteur

Câble USB (appareil externe)

Adaptateur USB

3 Appuyez sur la touche MENU pour afficher l’écran Menu. Sélectionnez USB Host
et appuyez sur la touche SELECT.

4 Utilisez la touche SELECT pour placer le curseur sur 'Please connect a slave
device [OK]' ('Veuillez connecter un périphérique esclave [OK]'), puis appuyez
sur la touche SELECT.
● L'écran Appareil externe apparaît.

I Connexion d’un appareil externe

Please connect a
slave device

05 I USB Host

OK Cancel

COPIED
GAME
MUSIC
PHOTO
PLAYLIST
RECORDED

Slave Device

● Pour pouvoir utiliser la fonction Hôte USB, la capacité du périphérique externe doit être
supérieure ou égale à 128 Mo.

● Le périphérique externe doit posséder un système de fichiers FAT 16/32.
● Cette caractéristique est compatible seulement avec les périphériques qui apparaissent

comme disques amovibles.

Appareil externe USB



1 Allez au fichier à transférer au lecteur et pressez la touche SELECT.
● ,▼ : permet de déplacer le curseur vers le haut ou vers le bas.

● SELECT : permet d’atteindre un sous-dossier ou de sélectionner un fichier.
● Appuyez sur la touche TOOL et sélectionnez [Select All] pour sélectionner tous les fichiers

enregistrés sur le périphérique externe.

2 Appuyez sur la touche TOOL pour afficher l’écran USB Tool, puis sélectionnez
[Cut] ou [Copy].
● Cut : Si vous collez le fichier sélectionné dans le YP-J70J, le fichier d’origine sera supprimé.

● Copy: Permet de copier le fichier sélectionné.
● Sélectionnez [Delete] à partir de l'écran USB Tool afin d'effacer le fichier sélectionné.

3 Appuyez sur la touche pour positionner le curseur sur [YH-J70J], puis appuyez
sur la touche SELECT.
● L’écran de navigation du YH-J70J apparaît.

I Transférer des fichiers d’un appareil externe au lecteur

01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave Device
01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
Iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave Device
01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
Iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave DeviceTOOL

Select all
Copy
Cut
Paste
Delete
USB Disconnec

Utiliser le port USB
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Utiliser le port USB

F
R

A
Continued...

4 Sélectionnez le dossier dans lequel le fichier du périphérique externe sera
copié.

5 Sélectionnez la touche TOOL pour afficher l’écran USB Tool, puis
sélectionnez [Paste].
● Le fichier sélectionné est transféré vers le lecteur. Ne débranchez pas le lecteur ou le

périphérique externe pendant le transfert de fichier.

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Pour transférer des fichiers depuis le lecteur vers un périphérique externe, suivez la même procédure.

✍

YH-J70J
Slave Device

USB HOST
01-As long as you lov
I’ll be there.mp3
01-Goodbye.mp3
go away.mp3
please.mp3
dreams come true.m

YH-J70J

01-As long as you lov
01-love.mp3
01-Goodbye.mp3
go away.mp3
please.mp
dreams come true.m

YH-J70JTOOL

Select all
Copy
Cut
Paste
Delete
USB Disconnec



I Hôtes compatibles avec le YH-J70J
● Vous pouvez transférer des images depuis n’importe lequel des appareils photo figurant dans

la liste ci-dessous vers votre YH-J70J.
● Vous trouverez ci-dessous une liste d’appareils photo compatibles avec la fonction Hôte USB du

YH-J70J.

● Cette liste peut varier en fonction des améliorations.

Lecteur MP3
(Samsung)

Caméra
numérique

ModèleModèleAppareil Appareil

Utiliser le port USB
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Fuji Finepix-A340

Fuji Finepix-F450

Fuji Finepix-F810

Panasonic Lumix-FZ20

Olympus 300-Digital

Pentax Optio-S40

H.P. Photosmart 945

NIKON COOLPix 4200

NIKON COOLPix 4300

NIKON COOLPix S1

Panasonic DMC-FX7

KENOX CYBER400

KENOX V10

KENOX U-CA5

YP-55

YP-MT6

YP-T6

YP-ST5

YP-T5

YP-53

YH-920

YP-T7

YP-C1

YP-60

YP-T8
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Jeux

F
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A

Niveau actuel

Nombre de pierres
restantes

● Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez GAMES à l’aide de la
touche NAVI. Appuyez sur la touche SELECT pour choisir le mode de jeu.

● Déplacez le curseur sur le jeu désiré à l'aide la touche NAVI, puis appuyez sur la touche SELECT.

1 Sélectionnez [START] à l’aide de la touche NAVI et appuyez sur SELECT pour
démarrer le jeu.

2 Sélectionnez le niveau à l’aide de la touche SELECT lorsque l’écran de
sélection du niveau apparaît.

[Règles du jeu]
- Le but du jeu est d’effacer l’écran.

Ex; : au niveau 1, si vous sélectionnez la pierre du milieu, les quatre directions sont
inversées et l'écran est effacé.

- ▲,▼ ,SELECT: permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une sélection.
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

I Clear Screen

START

HELP

EXIT

1

06 I Games
Clear Screen
Othello
Omock
Tetris
Chips

Games



1 Appuyez sur [START] pour commencer la partie.

[Règles du jeu]
- Lorsque vous placez vos pierres à l’horizontale, à la verticale ou en diagonale,

les pierres situées à l’intérieur entrent en votre possession.
Le côté comportant le plus de pierres à la fin de la partie gagne.

- ▲,▼ ,SELECT: permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une
sélection.

- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

I Appuyez sur [START] pour commencer la partie.

Nombre de pierres jaunes

Nombre de pierres roses

START

HELP

EXIT

54
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Jeux

F
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A1 Appuyez sur [START] pour commencer la partie.

[Règles du jeu]
- Le côté comportant 5 pierres droites sur des lignes horizontales, verticales ou

diagonales remporte la partie.
- ▲,▼ ,SELECT: permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une

sélection.
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

I Appuyez sur [START] pour commencer la partie.



1 Appuyez sur [START] pour commencer la partie.

I Tetris

2 Sélectionnez le niveau à l’aide de la touche SELECT lorsque l’écran de
sélection du niveau apparaît.

[Règles du jeu]
- Le but de ce jeu est d'éliminer les lignes en empilant des briques de formes

différentes.
- SELECT : modifier la forme des briques
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- ▼ : permet de faire descendre les briques rapidement vers le bas.
- TOOL: redémarrer, quitter

Niveau
Nombre de lignes à effacer avant de
passer au niveau suivant.

Score (Pointage)

START

HELP

EXIT

LINES :    30
SCORE :    0

Jeux
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F
R

A1 Appuyez sur [START] pour commencer la partie.

I Chips

2 Sélectionnez le niveau à l’aide de la touche SELECT lorsque l’écran de
sélection du niveau apparaît.

[Règles du jeu]
- Le but de ce jeu est d’atteindre la porte finale en déplaçant des obstacles et en

obtenant des clés et des objets. Vous ne pouvez franchir la porte que si vous détenez
la clé et  vous ne pouvez passer au niveau suivant qu’après avoir ramassé le nombre
d’objets requis pour chaque niveau.

- ▲,▼ : permet de déplacer le curseur vers le haut, vers le bas et d’effectuer une sélection.
- , : permet de déplacer le curseur vers la gauche ou vers la droite
- TOOL: redémarrer, quitter

Niveau
actuel

X

START

HELP

EXIT

Le nombre d’objets qu’il vous reste à ramasser
avant de passer au niveau suivant.



1 Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez Settings.

2 Dans Settings, allez à la fonction que vous désirez et pressez la touche SELECT.
● Pressez la touche pour aller au menu précédent.

Display
Sound Effect
Time/Schedule
Record
System

Settings

Display
Sound Effect
Time/Schedule
Record
System

Settings

Display
Sound Effect
Time/Schedule
Record
System

Settings
Display
Sound Effect
Time/Schedule
Record
System

Settings

Display
Sound Effect
Time/Schedule
Record
System

Settings

08 I Settings

Fonctions avancées
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Réglage de l’affichage
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● Utilisez la touche SELECT pour régler la vitesse de
défilement et ainsi ajuster la vitesse de déplacement
du titre de la piste.

● La vitesse de défilement peut être réglée sur 0.5x, 1x,
1.5x ou 2x.

I Scroll Speed (Vitesse de défilement)

● Utilisez la touche SELECT pour régler la durée de rétro-
éclairage.

● La durée de rétro éclairage peut être réglée sur Off,
3 secondes, 5 secondes, 10 secondes ou Always On.

● Lorsqu’il est réglé sur Always On, le rétroéclairage
fonctionne en permanence.

I Backlight (Rétroéclairage)

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [Display].

0.5x
1x
1.5x
2x

Scroll Speed

Off
3 sec
5 sec
10 sec
Always On

Backlight



● Utiliser la touche SELECT pour effacer le temps de l'écran ACL.
● Il est possible de régler la durée avant extinction de l'écran

ACL sur 3 secondes, 5 secondes, 10 secondes, 20 secondes,
30 secondes ou Always On (Toujours actif).

● Lorsqu'il est réglé sur Always On, l’écran ACL reste 
continuellement allumé.

● L’écran s’éteint une fois cette durée écoulée.
L’écran se rallume si une touche est enfoncée.

I LCD Off Time (Temps de fermeture écran ACL)

3 sec
5 sec
10 sec
20 sec
30 sec
Always On

Lcd Off Time

1 Sélectionnez la couleur de votre choix pour le texte.
● , : Permet de déplacer le curseur vers la gauche

ou vers la droite

● ▲,▼, SELECT: Sélectionner

2 Une fois l’heure réglée, allez sur OK, puis appuyez
sur la touche SELECT.
● Si vous sélectionnez une couleur, le texte s’affiche dans cette couleur.

I Text Set (Réglage du texte)

● Réglez le format d’affichage de l’écran à l’aide de la touche SELECT.
● Il est possible de régler l’affichage de l’égaliseur graphique sur Graphic EQ1,

2 ou Tag Info.
● Si vous sélectionnez l’option Tag info, les informations tag (étiquette) du 

fichier musical s'affichent à l'écran.

I Graphic EQ (Graphique égalisateur)

OK Cancel

Color

Text Set

Durée avant extinction de l’écran ACL
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Réglage des effets sonores

F
R

A1 Sélectionnez les niveaux 3D et de Bass Enhance 
(amélioration des basses) désirés.
● Les niveaux 3D et de Bass Enhance sont appliqués seulement 

quand l'option 3D-User est sélectionnée. Vous pouvez régler 
l’effet 3D de et Bass Enhance de 0 à 3.

● SELECT: Permet de déplacer le curseur vers le haut ou vers 
le bas et sélectionne l’option choisie.

● , : Permet de régler le niveau.

2 Une fois le réglage terminé, déplacez le curseur sur OK et appuyez sur la touche SELECT.

- Activez le mode Street à l’aide de la touche SELECT.

- On : Il est possible d’entendre des sons de meilleure
qualité quand vous écoutez de la musique dans la rue.

- Off : Les pistes sont lues dans le mode que vous avez
sélectionné.

I 3d User Set (Réglage option 3D)

I Street Mode (Mode rue)

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [Sound Effect].

- Protégez vos oreilles en augmentant le son
progressivement lorsque la lecture commence.

● Utilisez la touche SELECT pour sélectionner la durée de
fondu désirée.
- Off : la musique est lue selon le volume sonore sélectionné.
- 3 sec : le volume sonore de la musique augmente

progressivement pendant 3 secondes.
- 5 sec : le volume sonore de la musique augmente

progressivement pendant 5 secondes.

I Fade In (Fondu)

Off
3 sec
5 sec

Fade In

on
Off

Street Mode

OK Cancel

3D
3

Bass Enhance

3D User Set

2



● Utilisez la touche SELECT pour sélectionner Automatic EQ On/Off.
● On : L’égaliseur est automatiquement sélectionné parmi les valeurs Jazz, Classic, Pop ou Rock

en fonction des informations contenues dans l’étiquette ID3 du fichier musical.
● Off : Le fichier musical est lu dans le mode EQ choisi

I Auto EQ (Égalisateur automatique)

MODE EQ INFOS DE L'ETIQUETTE

CLASSIC ROCK, CHRISTIAN ROCK, ROCK,
ALTERNROCK, INSTRUMENTAL ROCK,

ROCK
SOUTHERN ROCK, ROCK & ROLL, HARD ROCK,
FOLK-ROCK, GOTHIC ROCK, PROGRESSIVE ROCK,
PSYCHEDELIC ROCK, SYMPHONIC ROCK,
SLOW ROCK, PUNK ROCK, DEATH METAL

CLASSIC
CLASSIC, OPERA, CHAMBER MUSIC
SONATA, SYMPHONY

JAZZ JAZZ, JAZZ+FUNK, ACID JAZZ

POP
POP, INSTRUMENTAL POP, POP-FOLK, DANCE
EURODANCE, DANCEHALL, DISCO, HIP-HOP

On
Off

Auto EQ
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Réglage des effets sonores

- Si le mode User EQ est sélectionné, il est possible
de paramétrer vous-même l’égaliseur.

● Utilisez les touches et pour déplacer le curseur
vers la gauche ou vers la droite et utilisez la touche
SELECT pour régler le volume.
Une fois l’heure réglée, allez sur OK, puis appuyez sur la
touche SELECT.

I User EQ Set (Réglage option égalisateur)

OK Cancel

User EQ Set

60     250    1K     4K     16K
125    500    2K     8K

+10dB

0dB

-10dB
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Réglage de l’heure/du calendrier
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- Créer des mémos et sauvegarder-les sur votre lecteur à l'aide de la fonction Memo.

1 Sélectionnez [New Memo] quand l’écran mémo apparaît.

2 Tapez le contenu désiré.
● Procédure de saisie

Déplacez le curseur sur la touche de votre choix
à l’aide des touches ▲,▼, et puis
appuyez sur la touche SELECT.
Appuyez deux fois sur la touche SELECT pour saisir la
deuxième lettre correspondant à la touche et trois fois 
pour saisir la troisième.

Ex. : pour saisir “MOVE”,
Mettez le curseur sur la touche sélectionnée,
puis appuyez sur la touche SELECT.

(Once) → (3 times) → (3 times) → (2 times)

● Sélectionnez pour supprimer une lettre et pour insérer un espace.

I Memo (Mémo)

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] →
[Time/Schedule].

Memo

OK Cancel

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Un mémo ne peut pas faire plus d’une page.

✍



Réglage de l’heure/du calendrier
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- Permet de savoir la date.

1 Appuyez sur la touche TOOL dans la fenêtre Calendrier.
● Day: permet de faire défiler les jours un à un.
● Month: permet de faire défiler les mois un à un.
● Year: permet de faire défiler les années une à une.

2 Placez le curseur sur la date que vous souhaitez
sélectionner.
● ▲,▼ : permet de déplacer le curseur vers le haut ou vers le bas.
● , : permet de déplacer le curseur vers la gauche ou vers la droite

3 Appuyez sur la touche SELECT après avoir vérifié les informations.
● L’écran précédent s’affiche.

3 Appuyez sur la touche TOOL.
● Keypad Set : Vous pouvez modifier le clavier.

Vous pouvez sélectionner Korean → Numeric  → Capital
English Font → Small English Font → Special
Characters (Coréen → Numérique → Anglais majus-
cules  → Anglais minuscules → Caractères spéciaux)

● Clear : Permet de supprimer le mémo.

4 Une fois la saisie terminée, allez sur OK, puis
appuyez sur la touche SELECT.

»≠∏È ¡̂ øÚ

OK Cancel

Keypad Set 
Clear

Tool

123
ABC
abc
!~^

Calendar
42005

3
10
17
24

4
11
18
25

5
12
19
26

6
13
20
27

7
14
21
28

1
8
15
22
29

2
9
16
23
30

I Calendar (Calendrier)

▲
▼

▲
▼

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Placez le curseur sur un mémo à supprimer dans l'écran Select Mémo, puis appuyez sur la

touche TOOL. Puis, sélectionnez [Delete] pour supprimer le mémo.

✍
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Réglage de l’heure/du calendrier
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- Vous pouvez régler le lecteur pour qu'il s'éteigne à une
heure prédéfinie.

1 Utilisez les touches et pour régler l'heure de 
la minuterie sommeil.
● Le temps de sommeil peut être réglé sur : off et de 

10 à 120 minutes. Le lecteur s’éteindra automatiquement 
après la durée réglée.

● Quand le temps de sommeil est réglé sur Off, la fonction est désactivée.

2 Une fois l’heure réglée, allez sur OK, puis appuyez sur la touche SELECT.

I Sleep (Sommeil)

● Vous pouvez régler l’heure et la date.

1 Placez le curseur sur Year, Month ou Day à l'aide de la touche Navi, puis sélec-
tionnez la date en utilisant les touches , .

2 Appuyez sur la touche après avoir placé le curseur sur Time.

3 Placez le curseur sur Hour, Minute ou AM/PM à l'aide de la touche NAVI.

4 Utilisez les touches et pour régler l’heure actuelle, puis appuyez sur la
touche SELECT.

5 Une fois l’heure réglée, allez sur OK, puis appuyez sur la touche SELECT.

I Date/Time (Date/Heure)

Sleep Time

OK Cancel

30 Min

Date/Time
2005

07 FRI
1 (JAN)

01:17 AM

OK Cancel

Year

Day
Month

Time

▼

▼

▼

▼

▼

▼
▼



Paramètres d’enregistrement
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Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [Record].

● Utilisez la touche SELECT pour sélectionner le débit
binaire d’enregistrement désiré.

● Le débit binaire d’enregistrement peut être réglé sur
40 kbits/s, 64 kbits/s, 96 kbits/s, 128 kbits/s ou
192 kbits/s.

I Bit Rate (Débit binaire)

● Utilisez la touche SELECT pour régler l’heure de
synchronisation automatique (Auto Sync Time).

● La fonction Temps de synchronisation automatique
sert a séparer et sauver les fichiers MP3 quand il
n’y a pas de son durant un enregistrement MP3.

● En Sync 1, l’enregistrement s’arrête et se met en
mode musical quand il n’y a pas de son pendant
plus de 2 secondes durant l’enregistrement.

● Quand la synchronisation automatique est réglée sur
Off, l’enregistrement continue même lorsqu’il n’y a pas
de son et est ensuite enregistré dans un seul fichier.

I Auto Sync (Sync. Automatique)

40 kbps
64 kbps
96 kbps
128 kbps
192 kbps

Bit Rate

Off
Sync1
On

Auto Sync
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Paramètres d’enregistrement
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Languages

Appuyez sur la touche MENU pour ouvrir le menu, puis sélectionnez [Settings] → [System].

● Utilisez la touche SELECT pour sélectionner la
langue d’affichage désirée pour les écrans de menu.

●

I Languages (Langues)

● Utilisez la touche SELECT pour sélectionner la langue
d’affichage désirée pour les étiquettes et le texte.

● English → Korean → Japanese → Simplified Chinese →
Traditional Chinese → Russian → Spanish → French →
German → Italian → Albanian → Afrikaans → Basque →
Bulgarian → Byelorussian → Catalan → Czech → Croatian →
Danish → Dutch → Estonian → Faeroese → Finnish →

Galician → Hungarian → Icelandic → Irish → Latvian → Lithuanian →
Macedonian → Norwegian → Polish → Porthguuese → Rhaeto-Romanic → Romanian →
Scottish → Serbian → Singaporean → Slovak → Slovenian → Swahili → Swedish → Ukrainian

I File Language (Dossier langue)

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Qu'est-ce qu'une balise ID3?

Voici une partie du fichier MP3 qui contient les renseignements pertinents au fichier, tels que le
titre, l'artiste, l’album, l’année, le genre et une zone commentaire.

- Les langues prises en charges peuvent être modifiées ou ajoutées.

✍

English
Korean
Japanese
Simplified Chinese
Traditional Chinese
Russian

File Language
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Paramètres Système

● Utilisez la touche SELECT pour sélectionner
Resume On/Off.

● On : La lecture reprend au point où elle s’est arrêtée.
En cas de fichiers texte, le texte reprendra à
l’endroit du fichier où se trouvait le curseur la
dernière fois qu’il a été ouvert.

● Off : La lecture reprend à partir du début du fichier/de
la piste qui était lu(e) au moment de l'arrêt. En cas de
fichiers texte, le texte reprendra au début du fichier.

I Resume (Résumé)

On
Off

Resume

● Utilisez la touche SELECT pour sélectionner le
mode de connexion au PC.

● MTP: Utilisez cette fonction pour transférer des
fichiers vers le lecteur ou pour transférer des
fichiers images et vidéo à l’aide de Windows
Media Player 10.0 ou Multimedia Studio.

● Charge: Permet de recharger le lecteur à l’aide du
câble USB.

● MTP + Charge: Mode de connexion qui permet à
l’utilisateur de recharger le lecteur tout en trans-
férant des fichiers.

MTP
Charge
MTP + Charge

PC Connect Mode

I PC Connect Mode (Mode connexion au PC)

RRRReeeemmmmaaaarrrrqqqquuuueeee
- Sur certains PC, il ne vous sera peut-être pas possible de connecter le lecteur en mode [MTP+

Charge]. Dans ce cas, connecter le lecteur en mode [MTP].

✍
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Paramètres Système
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NNNNooootttteeee
- Tous les fichiers resteront sur votre lecteur après avoir sélectionné l’option Default (Par défaut).

✍

No
Yes

Default Set● Utilisez la touche SELECT 
pour sélectionner Yes ou No 
en ce qui concerne les 
réglages par défaut.

● Si vous sélectionnez [Yes], 
une fenêtre pop-up apparaît.
Si vous sélectionnez [OK], tous les 
paramètres sélectionnés retrouveront leurs réglages par défaut.

I Default Set (Réglage par default)

● Réglez la durée avant extinction automatique de l'écran à l'aide de la touche SELECT.
● Désactivé → Après 30 sec → Après 1 min → Après 5 min → Après 10 min
● Si aucune touche n'est actionnée après la fin de la lecture, le lecteur s'éteindra automatiquement 

après la durée réglée.

I Auto Off Time (Temps de fermeture automatique)

● Sélectionnez le format de classement désiré à l'aide de la touche SELECT.
● Off : Les fichiers enregistrés ne sont pas classés.
● Type : Les fichiers enregistrés sont classés par ordre alphabétique selon les extensions de fichier.
● Name : Les fichiers enregistrés sont classés par ordre alphabétique selon les noms de fichier.

I Sort (Classement)

● Sélectionnez About (A propos de) pour vérifier la capacité totale, la capacité
disponible et la version du logiciel.

I About (A propos de)

Volume = 40

Répétition = OFF

Paramétrage des effets sonores = OFF

Contraste = 3 secondes

Paramètres initiaux
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MENU Table

∏fi¥∫»≠∏ÈMENU

MUSIC FM Radio Navigation Text Photo/Video USB Host Games Settings

Clear Screen

Othello

Omok

Tetris

Chips

Scroll Speed

Backlight

Lcd Off Time

Text Set

Graphic EQ

3D User Set

Street Mode

Memo

Calendar

Languages

File Language

Resume

PC Connect Mode

Auto Off Time

Sort

Default Set

About

Fade In

Auto EQ

Sleep

Date/Time

User EQ Set

Display Sound Effect Time/Schedule

Bit Rate

Auto Sync

Record System

● Utilisez la touche “SELECT” pour valider le menu désiré.
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Le lecteur ne fonctionne pas. Rien n’apparaît sur l’écran.
● Réinitialisez le lecteur en enfonçant un objet pointu dans le trou RESET situé à l'arrière du lecteur.
● Connectez le chargeur.
● Assurez-vous que la touche Hold est en position Off.

Il n’y a aucun son même si j’appuie sur la touche Lecture en mode Musique.
● Vérifiez que le lecteur contient bien des fichiers MP3 ou WMA.
● Les formats de fichiers non pris en charge (fichiers MPEG1 COUCHE 1 par exemple) ne

peuvent être lus.

Je ne parviens pas à télécharger des fichiers.
● Vérifiez le niveau de charge de la batterie.
● Vérifiez que le pilote est correctement installé sur votre PC.

Le lecteur sera déconnecté si vous relancez le PC alors que le lecteur est branché.
Essayez de reconnecter le lecteur.

Le rétroéclairage est éteint.
● Veuillez vérifier les réglages du rétroéclairage.
● Le rétroéclairage est automatiquement désactivé afin de prolonger la durée de lecture si la

batterie devient trop faible.



La durée de lecture affichée pendant la lecture semble erronée.
● Vérifiez si votre fichier est un fichier VBR (variable bit rate) Les fichiers VBR ne sont pris en charge

que partiellement.

Les touches du lecteur ne fonctionnent pas.
● Assurez-vous que la touche Hold est en position Off.
● Vérifiez si le câble USB est branché.

Les touches ne fonctionnent pas lorsque le câble USB est branché.

L’écran ACL est trop sombre.
● Vérifiez la durée de rétroéclairage/ la durée avant extinction de l’écran ACL.

Pendant la lecture, certains caractères inconnus s’affichent sur l’écran.
● Les langues non prises en charge sont signalées par un point d’interrogation (?).

"Null" apparaît sur l’écran de lecture à la place du titre du fichier musical
sélectionné.
● Il n’y a aucune information sur l’étiquette ID3 du fichier musical. Éditez le titre de la chanson,

l’artiste, l’album et les informations relatives à la chanson.

La recherche de chansons par Titre, Artiste ou Album demande beaucoup de temps.
● Si votre lecteur contient de nombreux fichiers musicaux, la recherche peut prendre un 

certain temps.
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Dépannage
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Après avoir sélectionné une autre langue que l'anglais, des caractères inconnus
s'affichent à l'écran.
● Connectez le lecteur à votre PC.

Insérez le CD d’installation dans le lecteur CD-ROM. Sélectionnez [Contents] →
[J70J.fnt] et faites-le glisser vers [Samsung YH-J70J] → [Data].
Après avoir débranché le câble USB, éteignez le lecteur. Maintenez la touche √» enfoncée
pour allumer le lecteur.
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Modèle YH-J70J
Capacité de mémoire interne YHJ70J LB/LW (30 Go)

Capacité de la batterie rechargeable incorporée 950 mAh
Tension 4,2 V (batterie Li-ion rechargeable)

Dimensions/Poids 62 X 99.8 X 16,4 mm/135 g
Boîtier Plastique

Rapport Signal/Bruit 90 dB avec 20 KHz LPF (sur la base de 1 KHz 0 dB)
Puissance de la prise de sortie Écouteurs 20 mW (France 5mW/CH) (16 Ω)

Plage de fréquence de sortie 20 Hz~20 KHz
Plage de température de fonctionnement -5~ +35°C (23~95°F)

AUDIO : MPEG1/2/2.5 Layer3(8Kbps~320Kbps, 8KHz~48KHz), WMA,
Audio ASF (48Kbps~192Kbps, 8KHz~48KHz), Ogg (Q0~Q10)

IMAGE : QCIF 160x128

Nombre de fichiers lisibles Dossier normal : 1024 fichiers
Dossier enregistré : 999 fichiers

Fichiers pris en charge

L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée à une
utilisation privée non commerciale par l’utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à un
produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions 
du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.



Garantie Limitée Samsung
Samsung Electronics Canada Inc. (SECA) 
garantit ce produit contre tout défaut de fabrication.

SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant 
la période de garantie et qu'il s'agit d'un défaut de fabrication SECA se réservera le 
droit de réparer ou de remplacer l’appareil défectueux.

Toutes les réparations sous garantie doivent être effectuées par un Centre de 
service autorisé SECA. Le nom et l’adresse du Centre de service le plus près de 
chez vous peut être obtenu en composant sans frais le 1-800-726-7864 ou en 
visitant notre site web au w w w.samsung.ca

Main-d’oeuvre Pièces
un (1) an (au comptoir) un (1) an

Pour tous les modèles portatifs, le transport de l’appareil sera la responsabilité  
du client. Le reçu de vente original doit être conservé par le client car cela constitue 
sa seule preuve d’achat acceptée. Il doit le présenter au Centre de service agréé au 
moment où il fait la demande d’une réparation sous garantie.

Exclusions
Cette garantie ne couvre pas les dommages causés par un accident, un incendie, 
une inondation, un cas de force majeure, un mauvais usage ou une tension 
incorrecte. La garantie ne couvre pas aussi une mauvaise installation, une 
mauvaise réparation, une réparation non autorisée et tout usage commercial ou 
dommages survenus durant le transport. Le fini extérieur et intérieur de même 
que les lampes ne sont pas couverts par cette garantie. Les ajustements par le 
client qui sont expliqués dans le guide de l’utilisateur ne sont pas couverts en
vertu de cette garantie. Cette garantie sera automatiquement annulée pour tout
appareil qui aurait un numéro de série manquant ou modifié. Cette garantie est
valable seulement sur les appareils achetés et utilisés au Canada.



Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service à la Clientèle
1-800-SAMSUNG (7267864)

www.samsung.com/ca
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